
We got acquainted with the Site window in the first few chapters of this book—it’s a

great built-in FTP tool in which you can also manage local files across all your local

sites. Dreamweaver MX also offers tools that can better your experience working with

coworkers, workgroups, or even just working by yourself over different computers.

Dreamweaver’s collaborative features include file check-in and check-out, which is a

low-tech way of identifying who is working with which files. You mark the files you’re

working on with your name and e-mail address, and your coworkers will know not to

make changes to a file that someone else is working on. 

Design Notes are another nifty feature that helps you track characteristics of specific

files or folders. You can mark files as “in progress” or with version numbers, or you can

customize Design Notes and flag specific pages with comments. When Design Notes

were introduced in their nascent form in Dreamweaver 3, they were difficult to manage,

not very flexible, and they carried no visual flag in the Site window, so it was damn nigh

impossible to actually use them. Now, they’re much more user friendly, and they allow

for some innovative site management shortcuts.

Using Design Notes, you can also customize the columns in the site window, so that

you can sort files according to, for example, a version number or a file check-out name.

Additionally, you can run site reports to find all files carrying specific Design Notes flags.

And finally, we’ll show you the basics of setting up Dreamweaver to work with some pop-

ular content management or workflow programs, such as RDS, SourceSafe, and WebDAV. 
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✔ Tips

� To use any of the features in this chapter,

you must first define a local site. If you

have any sites listed in the Site window,

you’ve already done this (Figures 20.1

and 20.2). A local site is a folder desig-

nated within the Dreamweaver environ-

ment as the one that holds all the in-

progress and completed files for a specific

Web site. You may also define a remote

site, also known as a production server;

and a testing server, which is recom-

mended for sites that use an application

server. 

� To define a local site, see Defining a Local

Site.

 

� You do not need to use file check-in and

check-out in order to upload files. To

upload a file, a folder, or a batch of files to

a remote site, select the pertinent icons in

Local view and click on Put . To

download files from a remote site to your

computer, connect to the site, select the

files you want, and click on Get . 

Figure 20.2 On the Mac, the Site window shows Local
view on the right and Remote view on the left.

Figure 20.1 The Site window, in local view on a PC.
You must define a local site before you can use
Dreamweaver’s site management tools.
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Figure 20.3 The files with checkmarks have been
checked out; you can see the check-out names in the
Checked Out By column.

Using Names to Check
Files In and Out
If several people are collaborating on a site, it

might be helpful to know who put which file

where, and when they did it. (If there are only

one or two of you, you should already know

the answer.)

Checking out a file locks it on the remote

server and allows you to edit it locally, while

a flag appears on it (a red checkmark) that

says to others, “Can’t Touch This.” Checking

in a file unlocks it on the remote server, but

makes it read-only on your local site so that

you don’t accidentally edit a file that is not

checked out.

Think of it like a library book: When you check

out a book, no one else can borrow it until

you return it. When someone else checks out

a book, you can’t check it out yourself. When

you or the other person checks the book (or

the file, really) back in, anyone can access it.

Checking out a file marks the file with a green

checkmark, assigns your username to that file,

and locks it in the Dreamweaver Site window.

Other team members who use Dreamweaver

will not be able to overwrite locked files (files

checked out by another person). These files

can be overwritten by any other FTP client,

however. File check-out in Dreamweaver is a

simpler, user-based, and less secure approxi-

mation of CVS checkout, a Unix-based tool

used in production groups.

Files other people have checked out are marked

in the Site window with a red checkmark,

and the person’s check-out name appears in

the Checked Out By column in both the local

and remote panes (Figure 20.3).

3

Workflow & Collaboration
U

sin
g

 N
am

es to
 Ch

eck Files In
 an

d O
u

t



Setting up file check-in

Before you can check files in or out, you must

enable that option in the site’s definition.

To enable check-in and check-out:

1. From the Site window menu bar, select

Site > Edit Sites. The Edit Sites dialog box

will appear (Figure 20.4).

2. Select the site for which you want to set

check-in and check-out options, and click

on Edit. The Site Definition dialog box

will appear.

If the Basic tab is selected, click Advanced

to show those options. (We don’t need to

click through a wizard at this stage in the

game, do we?)

3. In the Category box at the left, select

Remote Info. That panel will move to the

front of the dialog box (Figure 20.5).

4. To enable check-in and check-out, click

that checkbox. More options for file

check-in will appear (Figure 20.6).

5. If you want to mark all files as checked out

when you open them in the Document

window, check the Check Out Files When

Opening checkbox. 

We suggest unchecking this option until

you get used to maneuvering uploads and

downloads within Dreamweaver. Other-

wise, every time you open a file, it will

retrieve it from the remote server, and

this may end up being more annoying

than helpful. On very clean site setups,

however, this may come in handy.

6. Type the name you want others to see

when you check out files in the Check

Out Name text box. This can be your full

name or your username, or it can be a

personal designation such as “My Laptop.”

Figure 20.6 Check the Enable File Check In and Check
Out checkbox (that’s a lot of checks) to show setup
information for using this feature with remote files.

Figure 20.5 The Remote Info panel of the Site
Definition dialog box, before file check-in is enabled.

Figure 20.4 Choose which site’s check-in preferences
to modify in the Edit Sites dialog box.
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Figure 20.8 You can see the .LCK files if you examine
the site with an FTP client other than Dreamweaver’s.
(This is WS_FTP for Windows.)

Figure 20.7 Check-out names, if they’ve been entered
with e-mail addresses, appear as clickable links in the
Site window. The checkout name schlomo appears with
the user’s name, ttowers@sirius.com, but if the
entered e-mail address is different, that e-mail
address will appear when the link is clicked.

7. If you want colleagues to be able to con-

tact you about checked-out files, type

your full e-mail address in the Email

Address text box. (See Tips, below.)

8. Click on OK. Now, each time you retrieve a

file from the remote server, it will be marked

as checked out, and each time you upload

a file, it will be marked as checked in.

✔ Tips

� If you decide to access your files from a differ-

ent computer and find you cannot perform

an upload because the files are checked out,

you can still upload or download them by

using a different FTP client, such as Telnet/

CVS, WS_FTP, Fetch, or Cute FTP.

� Even if you work alone, you might want

to use these features. For instance, if you

work on two different machines, you can

use check-out names such as PC and

Mac, or Home and Work, so you’ll know

where the latest version is hiding. 

� If you’re using the Check In/Out feature

to prevent others on your team from over-

writing each other’s work, make sure 

they are using Dreamweaver to manage

their FTP sessions. If they work with

another FTP program, however, they will

see Dreamweaver’s .LCK file listed after the

checked-out file. If you let them know what

this means, they can open the .LCK file,

see the checkout name, and contact you to

find out whether they can work on the file.

� If you use a valid e-mail address in the Site

Definition dialog box, your name will appear

as a link in the Checked Out By column in

the Site window (Figure 20.7). Just like

with a mailto: link in the browser window,

other users will be able to click the link

and pop open an e-mail message window

in their default e-mail client. Your e-mail

address will be supplied, and the name of

the file will appear in the subject line.
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About .LCK Files

When you check out a file using Dream-

weaver, a lock is placed on the file in the

Dreamweaver Site window. This lock is a

text file with the .LCK extension. .LCK

files are invisible in the Dreamweaver Site

window, but you can see them in a dif-

ferent FTP client (Figure 20.8).

An .LCK file contains the username of the

person who checked it out. This file also

shows the date and time of the checkout

in the time stamp.

You can see the date and time of a .LCK file

in most FTP clients in the date and time

column. The .LCK files we examined were

only 7 bytes each (there are 1000 bytes in 1

kilobyte), so they aren’t going to make you

run out of server space any time soon.



Checking Out Files
When file check-in is enabled, you’ll see two

new buttons on the Site window (Figure 20.9),

one for checking in and one for checking out.

You can use these just as you do the Get and

Put buttons described in the introduction to

this chapter—although if you use the same

old buttons, files will still be checked in and

out with your name.

To check out one remote file:

1. Connect to the appropriate site in the

Site window.

2. Select the file in the Remote Site panel

(Figure 20.10).

3. Click on the Check Out button .

4. Respond to the Dependent Files dialog

box (see Tips, below).

The file (and its folder, if necessary) will be

copied to the local site (Figure 20.11). To

open a file on checkout, see Tips, below.

You may have to refresh the Local site view

to see the file (or its folder, if that was freshly

created, too).

Figure 20.11 The file and its folder were both copied
to the local site, and the file appears with a green
checkmark—indicating you yourself checked it out—
in the remote site pane.

New folder

Checked out file

Figure 20.10 Select the file you want to check out in
the Remote Site pane.

Figure 20.9 The toolbar on the Site window will include
two new buttons after you enable file check-out.

Check Out Files button

Check In button
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✔ Tips

� You can double-click on a remote file in

the Site window to open the file in the

Document window. Dreamweaver will

download the file, but it will not mark the

file as checked out. Any changes you make

in the Document window will be saved to

the local copy, and you’ll need to upload

(or check in) the page when you’re done.

� If you already have a local copy of the file

you want to check out, a dialog box will

appear asking if you wish to overwrite your

local copy (see the upcoming Figures 20.15

and 20.16). Click Yes to download a new

copy, or click No and the file will not be

transferred.
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About Dependent Files

Dependent files include images, JavaScript files, media elements, and CSS documents. When you

check out or check in a page (or when you get or put a file without file check-in enabled), you

can choose to simultaneously trans-

fer these files in the Dependent Files

dialog box by clicking Yes. Click No

to upload only your selected files,

or Cancel to think about it for a

minute. Check the Don’t show me

this message again checkbox to

permanently dismiss this tool. 

If you dismiss the dialog box and you decide one day it’s useful and you want it back, you can

set preferences for it in the Site category of the Preferences dialog box. Once there, you can set

separate preferences for dependent files for upload (put) and download (get).



To check out more than one file:

1. Select the files or folders you want to check

out in the remote site (Figure 20.12).

2. From the Document window menu bar,

select File > Check Out (Site > Site Files

View > Check Out on the Mac), or click

on the Check Out button.

3. Respond to the Dependent Files dialog box.

The files will be transferred to the local site

(Figure 20.13). The files will get a green

checkmark and a .LCK file on the remote

server. Your check-out name will appear

in the Checked Out By column.

To undo a file check-out:

� After checking out the files, select File >

Undo Check Out (Site > Site Files View >

Undo Check Out) from the Site window

menu bar. 

If you get a dialog box advising you that

files will be overwritten, you can say Yes,

No, or Yes or No To All. See Figures 20.15-

20.16, next page.

Figure 20.13 After refreshing the site view, the new
folder and the files we checked out appear in the local
site pane.

Checked out files

Refresh button New folder

Figure 20.12 This time, we’re selecting multiple files.
The other files in this folder have been checked out by
someone else—if this image were color, you’d see that
the checkmarks are red.

Red checkmarks Files selected for check-out
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Figure 20.17 We checked the files back in, and now
there’s no name in the Checked Out By column. When
files have been checked into the site, they appear
locked in the Local pane of the Site window. That’s
because you’re supposed to check out a file before
you edit it locally.

Files are locked in  

local site after check-in

No check-out name

Checked in files

Figure 20.16 You may get a dialog box like this if you
try to overwrite a batch of files.

Figure 20.15 You may get a dialog box like this if you try
to overwrite a newer, single file, either when checking
in or checking out.

Figure 20.14 We updated the files that were checked
out earlier, and now we’re going to check them back in.

Checking In Files
After you’ve finished working on a file, you can

check it back in. That means two things: you’re

uploading the current version back up to the

live site (or the staging server), and you’re

freeing up the file so others can work on it. 

To check in files:

1. In the local site, click to select the files or

folders you want to check in (Figure 20.14)

2. From the Document window menu bar,

select File > Check In (Site > Site Files

View > Check In on the Mac). Or, click on

the Check In button .

3. Respond to the Dependent Files dialog box,

as well as the overwrite query dialog box

in Figure 20.15 or 20.16, if one appears.

The file will appear with a locked icon on

the local site. The Checked Out status will be

removed from the remote server and your

name will disappear from the Checked Out

By column (Figure 20.17).
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✔ Tips

� When you check a file back in, it gets

locked on your local machine, and a little

lock will appear instead of a checkmark.

That’s because Dreamweaver safeguards

the file so that you can’t work on it unless

you check it out first. If you need to work

on a locked file you’ve checked in, and it

hasn’t changed, and you don’t want to

bother checking it out again, just unlock

it. From the Document window menu bar,

select File > Turn Off Read Only (Macintosh:

Sites > Site Files View > Turn Off Read only).

You can also select Turn Off Read Only

from the File Management menu on the

Document toolbar.

� You can also check files in and out while

you’re working on them, if need be. On

the Document toolbar, select Check In or

Check Out from the File Management

menu (Figure 20.18). Files that you check

in will be saved automatically before they’re

put up on the remote site. Remote files

that you check out will overwrite your

work in the Document window. On the

other hand, you can also double-click a

file in the remote site, examine it in the

Document window, and then check it out. 

Figure 20.18 You can check in a file while you’re working
on it, but then it’ll lock. You can always select Turn Off
Read Only from the same menu to keep working on it.
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Figure 20.21

Enable Design
Notes by checking
the first box in the
Design Notes cate-
gory of the Site
Definition dialog
box. If you want 
to share Design
Notes and File View
Columns, select
the Upload Design
Notes for Sharing
checkbox.

Figure 20.20

Choose your local
site in the Edit
Sites dialog box. 

Figure 20.19

Design Notes let
you leave love
notes for your Web
design team. These
files are managed
each in their own
dialog box, where
you can enter status,
dates, comments,
and other data
about a file.

Setting Up Design Notes
Design Notes (Figure 20.19) allow you to

save workflow information about a file in an

attached file—they’re discrete XML/text

documents. That means you can save non-

public information along with a file, rather

than saving it as a comment inside a file.

Using Design Notes, you can flag files that

need attention, keep track of who’s worked

on a file, and store notes regarding just about

anything. 

In order to use Design Notes, you need to

enable the use of them with your local site.

To enable Design Notes: 

1. From the Site window menu bar, select

Sites > Define Sites. The Define Sites dia-

log box will appear (Figure 20.20).

2. Click on the name of the site for which

you want to enable Design Notes. 

3. Click on Edit. The Site Definition dialog

box will appear.

4. In the Category box at the left, click on

Design Notes. That panel of the dialog

box will appear (Figure 20.21).

5. If the Maintain Design Notes checkbox is

checked, leave it alone. If it’s unchecked,

check the box to enable Design Notes.

6. If everyone in your workgroup is using

Dreamweaver to produce a site, you may

want to upload Design Notes along with

their files. To enable automatic uploading

of Design Notes, check the Upload

Design Notes for Sharing checkbox. 

✔ Tips

� If you’re working alone on a project or if

your group isn’t using Dreamweaver as a

team, you should make sure to uncheck

the Upload Design Notes for Sharing

checkbox, or the server will be cluttered

with files useless to everyone but you.

11

Workflow & Collaboration
S

ettin
g

 U
p D

esig
n

 N
otes

� On the other hand, if you want to keep

notes on more than one machine, by all

means, share them with yourself. 

� To disable Design Notes, follow the steps

above and then uncheck the Maintain

Design Notes checkbox. See Turning Off

Design Notes later in this chapter, for

details on what this does. 
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Where Are The Files?

The first time you create a Design Note, Dreamweaver creates a folder called _notes.

Unfortunately, there isn’t one central folder—Dreamweaver creates a _notes folder for each

separate location of each separate file. For instance, if you create a Design Note for a page in

the site root folder, and then another note for an image in the /images folder, Dreamweaver

creates a _notes folder in each place.

What’s more, the _notes folders are not visible using the Site window; to open the folder, you

need to use your regular file manager (Windows Explorer or the Finder).

Inside the _notes folder, each Design Note is named for its file, plus an additional extension,

.MNO (Macromedia Notes). So if your file is called calendar.html, the Design Note will be

called calendar.html.mno.

Extending Design Notes

As we said at the beginning of this chapter, Design Notes have improved greatly since their initial

implementation in Dreamweaver 3. 

Although you can’t use Find and Replace with Design Notes or export only those files that

use them, you can run a site report that lists Design Note properties. 

Fireworks, Macromedia’s image editing program, also uses Design Notes. The source files 

in Fireworks are PNG files; when you export a PNG as a GIF, for example, Fireworks creates a

Design Note that lists the name and location of the original PNG file.

If you’re a developer, you can use XML and JavaScript to extend Dreamweaver to include a

Design Notes inspector or to use a status flag in a Design Note to change tags within a file.

You can also write extensions to site reports that search on specific HTML tags as well as on

Design Notes. If you’re not a developer, check the Macromedia Exchange (Help >Macromedia

Exchange) to see if other users have implemented Design Note extensions.
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Figure 20.24 Select an option from
the status menu. To add a status
value that doesn’t appear on this
menu, see Step 7 and use Status
as the Name.

Figure 20.23 Leave notes for yourself or your
coworkers in the Design Notes dialog box.

Figure 20.22 Access Design Notes for
the current page by selecting Design
Notes from the File Management menu
on the toolbar.

Using Design Notes
A Design Note is basically a hidden text file

that stores information about another file. You

can use Design Notes not only with Web pages,

but also with images, multimedia files, CSS

or HTML style sheets, library items, templates,

and any other file in your local site.

To create a Design Note:

1. Select the file you want to notate in the

Site window, or open it in the Document

window. Then, select File > Design Notes

from the Site window menu bar or the

Document window menu bar. 

You can also select Design Notes from the

File Management menu on the toolbar

(Figure 20.22).

Either way, the Design Notes dialog box

will appear (Figure 20.23), displaying the

name of the file and its site path/location.

2. The Status drop-down menu allows you

to flag a file with the following labels:

draft; revision 1, 2, or 3; alpha, beta, or

final; or needs attention (Figure 20.24).

You may select any or none of these.

continues on next page



Figure 20.25 Add formatted notes (name=value) in
the All Info tab of the Design Notes dialog box. These
are some examples of names and values you might
find useful.

3. To stamp the current date in the Design

Note, click on the Date button above the

vertical scrollbar in the Notes text box.

Today’s date will be printed in the Notes

text box.

4. Type any additional notes in the Notes

text box. 

5. To have Dreamweaver pop open the

Design Notes whenever the file is opened,

check the Show When File Is Opened box.

6. To add specific notes to be used consis-

tently from file to file, click on the All Info

tab to make that panel of the dialog box

visible (Figure 20.25).

7. To add a new note, click on the + (plus)

button. In the Name and Value text boxes,

type the information, such as “Project”

and “Intranet,” “Due” and “[Date],” or

“Author” and “vlad” (Figure 20.25).

8. When you’re done, click on OK to close

the dialog box and save your Design

Notes.

✔ Tip

� You can create file view columns to use

with the custom fields you create in Step 7.

See Adding File View Columns, later in

this chapter.
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Accessing Design Notes
Opening a Design Note for a Web page or

other file is similar to creating one. You open

the same Design Notes dialog box, and then

you can read and edit the Design Notes.

To open a Design Note:

1. In the Site window, select the file whose

Design Notes you want to read.

2. From the Site window menu bar, select

File > Design Notes. 

or

Double-click the Notes icon next to

the filename in the Site window. 

(On Windows machines, you must expand

the Site window to view the column for

Notes, where you’ll see the icon for any

files that use them.)

Either way, the Design Notes dialog box will

appear (Figure 20.26).

You can also open notes for a page in the

Document window by selecting Design

Notes from the File Management menu on

the Document toolbar (see Figure 20.22).

Now you can read, update, or edit the notes.

Figure 20.26 The Design Notes dialog box displays
information we saved earlier about the progress of
the page.



Figure 20.28 After we clicked on Clean Up, this dialog
box asked us if we were really sure we wanted to
clean up and delete the orphaned files.

Figure 20.27 A close-up of the Design Notes panel of
the Site Definition dialog box.

Cleaning Up Design Notes
After you delete a file, Dreamweaver does

not automatically delete its associated Design

Notes. You can clean up orphaned Design Notes

easily.

To clean up Design Notes:

1. From the Site window menu bar, Sites >

Edit Sites. The Edit Sites dialog box will

appear.

2. Click on the name of the site for which

you want to clean up Design Notes. 

3. Click on Edit. The Site Definition dialog

box will appear. 

4. In the Category box at the left, click on

Design Notes. That panel of the dialog

box will appear (Figure 20.27).

5. Click on the Clean Up button. A dialog box

will appear (Figure 20.28) asking you if

you really want to do that. Click on Yes.

6. Dreamweaver will remove all orphaned

Design Notes from the selected site.
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Turning Off Design Notes
Before you disable Design Notes, keep in mind:

� When you disable Design Notes,

Dreamweaver can remove notes and

_notes folders from your site. 

� When Design Notes are disabled, you

cannot use Personal or Shared File View

Columns, and you cannot use any Site

Reporting features that include Design

Note properties. We cover using both

these functions in detail later in this

chapter.

To disable and delete all

Design Notes:

1. Follow Steps 1–4 in the previous list.

2. Uncheck the Maintain Design Notes

checkbox. If you have File View Column

Sharing enabled, a dialog box will appear

(Figure 20.29). Click on OK.

3. Click on OK to close the Site Definition

dialog box and save your changes. Another

dialog box will appear, asking you if you

want to delete Design Notes (Figure 20.30).

Click on Yes to delete them or No if you

want to keep them around. 

Figure 20.30 You can now choose whether or not to
delete all Design Notes after you disable maintaining
them.

Figure 20.29 If you have File View Column sharing
enabled, Dreamweaver will warn you that turning off
Design Notes will turn off the columns.



Figure 20.31 The File View Columns panel of the Site
Definition dialog box allows you to rearrange and hide
columns, as well as add new ones.

Modifying Columns in the
Site Window
In the Site window in Dreamweaver MX, you

can add or remove columns, called File View

Columns. You can hide columns you don’t

use, and you can also create columns that

are associated with particular Design Notes

attributes. 

✔ Tip

� On Windows machines in Dreamweaver MX,

the column headers are visible only if you

expand/undock the Site window, as seen

in the figures in this chapter. When the

Site window is docked as a panel, only file

and folder names are shown.

To show or hide an existing column:

1. From the Site window menu bar, select

Edit Sites. The Edit Sites dialog box will

appear.

2. Select the site for which you want to define

new columns, and click on Edit. The Site

Definition dialog box will appear. 

3. In the Category box at left, select File View

Columns. That panel of the dialog box

will appear (Figure 20.31).
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Figure 20.33 This is standard text alignment in the Sites
window (local view only, in this figure). To see more or
less of what’s in a column, you can experiment with
rearranging alignment options. Note that the Notes
column has Center alignment set, but it still looks like
left alignment.

Figure 20.32 Here, we’ve hidden all but the Name and
Modified columns.

4. Six built-in columns are displayed by

default in the Local view of the Site 

window. These are: Name (filename),

Notes (a note icon appears for pages 

with Design Notes; only shown when

Design Notes are enabled), Size (file size),

Type (file type, such as HTML or GIF),

Modified (date last changes were saved),

and Checked Out By (check-out name;

only shown when file check-in is enabled).

To show or hide any of these columns

(except Name) or a column you create

yourself, check or uncheck the Show

checkbox in the options area of the dialog

box. Figure 20.32 shows the Site window

with all but the Name and Modified fields

hidden. 

5. You can also change the alignment of

the text in a column. Figure 20.33 uses

default alignment settings. The Name

column is set to Left, so that the begin-

ning of the filename shows; the Notes

column is set to Center, so that Notes

icons are centered in that column; and

the File Size column is set to Right, so

that the numbers line up with the file

size. You can change any of these. 



Figure 20.34 Here, we’ve rearranged the standard
columns.

To reorder columns in the

Site window: 

1. In the File View Columns panel of the Site

Definition dialog box, select the name of

the column you want to move to the right

or left in the Site window. 

2. To move the column (Figure 20.34), click

on the Up arrow to move it to the left or

the Down arrow to move it to the right

(Figure 20.31).

✔ Tips

� One quirk of Design Notes is that if you set

only an option that is matched with a col-

umn, you will not see an icon for the Design

Note. That is, once you create a “Status”

column, a Design Note that carries only

information for “Status” will not also get

flagged with a little doohickey. Design

Notes do get icons if you type anything at

all in the text boxes. See Adding File View

Columns for an example of tagging flags

in the Site window, including “Status,” to

specific Design Notes settings.

� After you add personal columns to your

site, you can of course rearrange them,

show them and hide them, and so on.
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Figure 20.37 Here
we’ve added a brand-
new column called
SSI, which corre-
sponds to custom
settings we added 
in the All Info section
of Design Notes.
SSI, in case you’re
wondering, refers to
server-side includes,
and these settings
are the name of the
include the file uses.

Figure 20.36

We’ve added a Status
column, in which 
the labels correspond
to status settings 
in Design Notes on 
this site.

Figure 20.35 Click
on the + (plus)
button to create a
new column in the
Sites window.

✔ Tip

� In the Associate With Design Note drop-

down menu (Figure 20.35), the fields

listed include assigned, due, and priority,

but these are only suggestions—first off,

they don’t yet exist until you add them to

a Design Note, and second, you can add

your own names by typing them in the

text box. Other ideas for columns include

author names, include or template

names, style sheet version names, and

weekly or daily site sections. See Using

Design Notes, earlier in this chapter, to

find out how to create these fields and

make them available to all Design Note

files in your site. 

Adding File View Columns
Not only can you show or reorder existing

columns, you can add your own columns to

the Site window. These columns can display

Design Note details, such as the status of a

file or other custom fields that you create.

To create a new column in the

Site window:

1. Design Notes must be enabled in order

for you to add personal or shared columns.

See the preceding sections on setting up

and creating Design Notes. 

2. Follow steps 1–3 under To show or hide

an existing column earlier in the chapter

to display Site View Column details in the

Site Definition dialog box. 

3. Click on the + (plus) button. A new

Personal column called untitled will

appear (Figure 20.35).

4. Type the display name for the column as

you want it to appear in the Site window

in the Column Name text box.

5. To associate the column with a Design

Note field, select it from the Associate

With Design Note menu. Not all these

fields are already in the Design Notes;

see Tip, below. If you have not yet created

the field in your Design Notes, you can 

go ahead and type it in the text box

and create it later.

6. To set alignment of the text in the column,

select Left, Center, or Right from the

Alignment menu. 

7. Click on OK to close the Site Definition

dialog box and add the column to the Site

window.

In Figure 20.36, we’ve added the Status column,

which will now display the status we’ve set

for files with Design Notes. In Figure 20.37,

we’ve created a new Design Note category

called SSI and added a column for it. 



Figure 20.41 Users who share access to this site will
see the columns we added, Status and SSI, on both
their local and remote site. They can hide the columns
if they want to.

Figure 20.40 When you select the Share With
All Users of This Site checkbox, the column type
will turn from Personal to Shared, and those
columns marked as shared will be uploaded.

Figure 20.39 If you haven’t yet enabled uploading of
Design Notes and you want to share columns, this
dialog box will ask you to turn on that option.

Figure 20.38 Check the Enable Column Sharing
checkbox to upload your Design Notes containing file
view column information.

Sharing Columns
If you’ve created a handy column and you

want your coworkers or your other machines

to be able to use it, you can share the column

information.

To share column information:

1. Create a new column, as described above.

2. In the File View Columns category of 

the Site Definition dialog box, check the

Enable Column Sharing checkbox

(Figure 20.38). 

If you have not previously enabled Design

Note sharing in that category of the site

definition, a dialog box will appear asking

if you wish to do so (Figure 20.39). Click

on OK.

3. In the File View Columns panel of the

Site Definition dialog box, select the 

column you created. 

4. Check the Share With All Users of This

Site checkbox. The column Type will

change to Shared (Figure 20.40).

5. Click on OK to close the Site Definition

dialog box and share the column with

other users.

The next time your colleagues connect to or

refresh their view of the Site window for the

selected site, they’ll see the new column and

the new data (Figure 20.41). They can hide

this column if they don’t want to use it. Keep

in mind that anyone can edit or add columns—

they can’t rearrange the columns in your

window, but they can add and rename any

Shared column on this site.

✔ Tip

� You can enable column sharing before

you create any columns. In the Design

Notes category of the Site Definition

dialog box, check the Upload Design

Notes for Sharing checkbox.
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Editing personal or
shared columns

You can delete a column, rename one, or

associate it with a different Design Note

field at any time. If this is a shared column,

the change will affect all users who share

Design Notes on your site.

To edit a column:

1. In the File View Columns panel of the Site

Definition dialog box, select the name of

the column to edit. You cannot rename or

delete a Built In column. 

2. To delete the column, click on the - (minus)

button.

3. To rename the column, type a new name

in the Column Name text box. 

4. To associate the column with a different

Design Note, select a new note from the

Associate With Design Note menu, or

type a new name. 
Using Site Reports

with Design Notes

Site reports allow you to run a check on

your site that looks for specific character-

istics. The report then gives you a list, in

the Results panel group, of all pages in

your local site that have the criteria you

specified.

In the Site Reports dialog box (Site >

Reports) you can run a check for all files

that use Design Notes, but you cannot

specify other search parameters for Design

Notes. You can, however, search only a

specific folder for Design Notes. 

You can search for a specific check-out

name. Check the Checked Out By check-

box, and then click on Report Settings

and type the name you’re looking for. 



Using Dreamweaver with
Content Management
Content management systems, affectionately

known as CMS, can be a godsend to large

workgroups that are trying to keep track of

who touched what file when and whether it’s

ready for primetime. You must already have

these tools installed in order to use them. 

(We bet you knew that.)

The following systems, which Dreamweaver

supports, may not be called CMS in your

workplace, but we’re placing them under this

rubric because they all serve as intermediaries

between your local machine and your Web

server. Dreamweaver MX supports WebDAV,

RDS, and the Visual Source Safe database.

Using WebDAV

WebDAV (pronounced Web Dave) stands for

the Web-based Distributed Authoring and

Versioning protocol. It’s an open standard

that’s basically an extension of the standard

HTTP Web server protocol, and the system

allows users to track and edit remote files from

their local machines. WebDAV is designed to

promote collaboration and accountability. 

Many free and commercial products are

available for working with WebDAV, includ-

ing tools for Apache and Microsoft IIS. Once

you have WebDAV installed, you (and your

colleagues) can mount a WebDAV drive on

your desktop as if it were an AppleTalk or

local network machine, and then browse and

open the files and folders on a remote Web

server just as easily as on your own hard drive. 

Using WebDAV instead of standard FTP

provides stronger security and interoperability

features not available with FTP (such as

authentication, encryption, proxy support,

and caching). Using WebDAV with Dream-

weaver shows the contents of the WebDAV

drive in the Remote pane of the Site window. 
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Figure 20.44 In the WebDAV Connection
dialog box, specify the URL for the Web
server that uses WebDAV.

Figure 20.43 A close-up of the
options for WebDAV. You can set
check-out options like the ones
described earlier in this chapter.

Figure 20.42 Select WebDAV from
the Access drop-down menu in the
Site Definition dialog box.

Setting up WebDAV 

When you work with WebDAV using Dream-

weaver MX, you set up your remote connection

so that WebDAV is your remote site, rather

than your FTP or local network server.

To set up your remote site info to work

with WebDAV:

1. Open the Site Definition dialog box for

the appropriate local site. 

If the Basic tab is in front, click on

Advanced.

2. In the Category list, select Remote Info.

3. From the Access drop-down menu, select

WebDAV. The dialog box will change

appearance (Figure 20.42).

4. To set up automatic file check-out with

Dave, select that checkbox (Figure 20.43). 

5. Click on Settings. The WebDAV

Connection dialog box will appear

(Figure 20.44). 

The URL may use local server info, but it

must include both the protocol and the

port number for Dave. An example would

be http://staging/WebDAV/home.

Your username and password must be

those you use with that server. Your e-mail

address will be attached to your WebDAV

check-out name and will appear with your

files in the Checked Out By column of the

Site window.

6. Click on OK to save your settings, and OK

again in the Site Definition dialog box.

You’re all ready to go. You can use Get,

Put, and all the other features as usual,

except you’re using them with Dave’s help. 
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� To find out more about installing and

using WebDAV, visit www.webdav.org. 

� Other products offer WebDAV integra-

tion, include Adobe Acrobat, Microsoft

Office and Internet Explorer, Mac OS X,

and content management software such

as Vignette and Documentum. 



Using Visual Source Safe
Databases with Dreamweaver

Microsoft Visual Source Safe is a version

control system for all sorts of code, including

HTML, scripts, and images. It’s a content-

management database that supports file

sharing, branching, and merging, makes

backups of source code, and prevents more

than one user from accessing a piece of code

at one time (thereby rendering each other’s

work either redundant or incomplete). VSS

is particularly handy, according to Microsoft,

if you’re working with chunks of ASP.NET code.

Dreamweaver MX emulates VSS client ver-

sion 6 and can be used with version 5. Use

with the Mac is not supported in MX (see

Tip, after the list below).

When you work with VSS using Dreamweaver,

you set up your remote site information so

that VSS is your remote site, rather than your

FTP or local network. The contents of the VSS

database will appear as the files and folders

in the remote pane of the Site window.

To set up your remote site info to work

with VSS:

1. Open the Site Definition dialog box for

the appropriate local site, and click on

Advanced if the Basic version is showing.

2. In the Category list, select Remote Info.

3. From the Access drop-down menu, select

SourceSafe Database. The dialog box will

change appearance (Figure 20.45).

4. To check-out files from VSS when you open

them, select that checkbox (Figure 20.46). 

Figure 20.46 A close-up of the options for Visual
SourceSafe. You can enable Dreamweaver’s file
check-out and automatic upload, if you wish.

Figure 20.45 Select SourceSafe Database from
the Access drop-down menu in the Site Definition
dialog box.
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Figure 20.47 In the Open SourceSafe Database dialog
box, specify the location of the VSS database file.

5. Click on Settings. The Open SourceSafe

Database dialog box will appear 

(Figure 20.47). 

6. In the Database Path text box, type the

address of the VSS database, or click

Browse to select the database file. This

file is the srcsafe.ini file used to initial-

ize SourceSafe when you connect using

the Site window.

7. In the Project text box, type the name of

the VSS Project that you want to use as

the root folder for your remote site.

8. The username and password you enter

must be those you use to log in to VSS. To

save your password, select that checkbox.

9. Click on OK to save your settings, and OK

again in the Site Definition dialog box.

You’re all ready to go. You can use Get, Put,

and all the other features as usual, except

you’re using them on VSS.

✔ Tip for Mac Users

� Dreamweaver MX no longer directly sup-

ports use with Visual SourceSafe on the

Macintosh, and Microsoft no longer pro-

duces a Mac OS version of SourceSafe.

However, it’s possible to fudge use of VSS

by setting up FTP or Local/Network

information to reflect the location of the

VSS server rather than the regular Web

server—of course, your mileage may vary.

To work with VSS on the Mac, you must

have the MetroWerks SourceSafe client

and ToolServer tools, and you can work

with VSS version 5.0, but not 6.0. Visit

www.metrowerks.com for downloads and

information. Dreamweaver 4 supports

use of VSS with Mac using the 1.1.0 client. 
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Using RDS with ColdFusion
Server and Dreamweaver

RDS, remote development services, is a pro-

tocol used with ColdFusion servers. RDS is

similar to WebDAV in that it is based on the

HTTP protocol (rather than FTP), and it

allows the user remote interaction with the

files, folders, and databases on a ColdFusion

server. 

If you use RDS with Dreamweaver, you work

directly with the files on the server, and the

files in your local site folder can be consid-

ered to be merely locally stored back-up

copies of the existing pages you’re managing,

rather than the files you operate with until

you upload.

Additionally, setting up RDS information to

work with the ColdFusion server allows you

direct access to the ColdFusion server files

not only in the Site window but in

Dreamweaver’s other application server

tools, such as the Databases panel. 

To set up Dreamweaver to work

with RDS: 

1. Open the Site Definition dialog box for

the appropriate local site, and click on

Advanced if the Basic version is showing.

2. In the Category list, select Remote Info.

3. From the Access drop-down menu, select

RDS. The dialog box will change appear-

ance (Figure 20.48).

4. To check-out files from RDS when you

open them, select that checkbox

(Figure 20.49). 

Figure 20.49 A close-up of the options for RDS. You
can enable Dreamweaver’s file check-out and
automatic upload, if you wish.

Figure 20.48 Select RDS from the Access drop-down
menu in the Site Definition dialog box.
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Figure 20.50 In the Configure RDS Server dialog box,
specify the host name of the server using RDS, as well
as your user information.

5. Click on Settings. The Configure RDS server

dialog box will appear (Figure 20.50). 

6. In the Host name text box, type either the

IP number or the URL of the ColdFusion

server. 

7. In the Port text box, set the port number

you communicate with. For HTTP, this

port is 80, but check with your adminis-

trator if you’re not sure. 

8. In the Full Host Directory text box, type

the full address of the remote root direc-

tory that contains your files. An example

is c:\server\www\hostdirectory. 

9. The username and password informa-

tion here can be tricky—the options you

complete here basically vary based on

how the server security is set up. 

� If you have a username and pass-

word, go ahead and type them. 

� If you are running ColdFusion server

locally, these options may not appear

at all; don’t worry about it. 

� If you do not have a username, or if

you connect using a DSN, you can

specify only the server password. If

you have neither a username nor a

password but connect as part of a

“user group” you can try leaving these

options blank; otherwise, contact the

administrator and have them set up

or provide a password for you.  

10. Click on OK to save your settings, and

OK again in the Site Definition dialog

box. You’re all ready to go. You can use

Get, Put, and all the other features as

usual, except you’re using them to inter-

act with the ColdFusion server using

RDS as the intermediary.
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Ye Olde Microsoft RDS

RDS, which in the world of Microsoft stands for remote data services, is an interoperability

platform originally designed to manage live data in Access or Visual Basic databases by allow-

ing the user to manage the data using forms in a Microsoft Web browser. Like the RDS used

with ColdFusion, it’s basically just an intermediary way for an administrator to interact with a

database.

Microsoft RDS permits interaction with local or remote ODBC database connections and is

particularly useful for managing ASP data. 

RDS can be considered a precursor to Web services, and it also allows insertion of recordsets

onto Web pages by defining the data strings as MIME types, similar to plug-ins (remember

ActiveX, anyone?).

Microsoft has deprecated RDS and may remove it from future releases of its Microsoft Data

Access Components (MDAC). However, its constituents are big fans, even though the tool is

optimized for use with Internet Explorer 4.0 and doesn’t work precisely the same way with

later versions. 

(Those of you who are more familiar with single-user software packages may be surprised to

know that people who run servers don’t necessarily upgrade every time something new comes

down the pike, because if you find something you like in the data-management world, it’s gen-

erally easier and better to stick with the known-and-liked quantity than to build your systems

all over again, unless there’s a serious security risk.)

Engineers who have decided to replace RDS components usually do so using a combination of

XML Web Services and either ASP.NET server-side controls or the Microsoft SOAP toolkit. Of

course, if you wanted to change horses completely, you could commit to ColdFusion and its

own, not-too-dissimilar RDS. 
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